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I have a nice high resolution PNG. (Download from Dropbox)
When I paste this into a new Word document, it looks good. I can't zoom in more than 500% but at that zoom level all lines are smooth, as expected.


Now I click File > Save as and select PDF from the Dropdown. From Tool > Compress Images (right next to the save button) I select "use document resolution". Then, I hit save.


Expected: The image in the PDF (viewed in Adobe Reader) should have a similar quality as the PNG.


Reality: The Image is much worse than the PNG. Maybe downsampled to 96ppi.


Notes:


	When I am in the save dialog and I go again to Tools > Compress Images, the selected option is reverted to "E-Mail (96 dpi)"
	I tried the same thing on a diffewrent computer with Word 2013, but no luck.
	I tried a different PDF viewer - same image quality
	I tried to encode normal 96 ppi within the PNG and resize the image in word.
	The option "do not compress images in file" is enabled. This option:
()
	This is a reduced problem, so please don't suggest GIMP. My real file has some text in it. Until now I am just reluctant of redoing it all in LaTeX.
	The problem gets worse, when the image is further reduced within word. This points to a resampling going on when the pdf is created.



Additional thing I have tried:


	When I use "Printing (220ppi)" instead of "document resolution" there is no discernible difference. (After all I thought that "document resolution" means that no resampling takes place and the full resolution is used.)
	Exporting to XPS format has the same characteristics.



Question: How can I preserve the image quality when exporting to PDF?
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                Compliments to this very accurate and neatly detailed question! I wished every question would be like this. What kind of Office are you running? I gave it a shot with Office 2007, Microsoft's PDF plugin, a high-res png and the pdf came out alright
                
                
– Zerobinary99
                

                Sep 15, 2013 at 14:51
            

        

    
	
        
            
            

        

        
            
                
                Thanks :-) I use Word 2010, but have the same issue with Word 2013 on my laptop.
                
                
– DasKrümelmonster
                

                Sep 15, 2013 at 14:53
                        
                            
                        
            

        

    
	
        
            
                    1
            

        

        
            
                
                FWIW I don't know of a way other than using a 3rd-party PDF maker with the relevant higher-res settings.
                
                
– user181946
                

                Sep 15, 2013 at 15:32
            

        

    
	
        
            
            

        

        
            
                
                I would use Ginmp to open the PNG files and then export each to PDF. Check the result for quality and see if it's up to your standard. :)
                
                
– Darius
                

                Apr 17, 2014 at 18:14
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                OP, this now 2 1/2 year old question is still getting answers, some not-very-high quality.  Please select an answer so this can close.
                
                
– JoelAZ
                

                Feb 18, 2018 at 20:21
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Any easier solution might be to forego the in-built pdf conversion and use a pdf printer (I use pdfcreator)   You'll likely find finer grained control (including DPI settings of the printout - start w/ 600x600 but it supports up to 2400x2400 iirc). 


This may be an easier solution as it won't force you to reformat existing docs.  It's also free.


As discussed in comments, at some point pdfcreator was engaged in installing some unwanted software along with their package.  I believe they have since stopped this practice but to ensure you do not ever have to deal with or think about this I suggest using Ninite to install.  Ninite's installer will strip out all the BS (if any) and install silently for you, which is nice.  You can also re-run the ninite installer any time to update the software, again without any BS.  Just in case.


EDIT - as per ThomasK this printing will not preserve hyperlinks in your output PDF.
(I assume they will print, just not be clickable)
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                Thanks! Should be the answer IMO. When installing PDFCreator, I suggest using Expert Mode > Deselect PDFArchitect (60MB!) + help files/languages. When printing, default settings worked a charm for me.
                
                
– Dunc
                

                Oct 8, 2014 at 9:53
            

        

    
	
        
            
            

        

        
            
                
                Wow. It might be free, but it has been a while that I saw so many spamware in a download. I thought I ticked everything off and now I still end up with my Chrome default search settings screwed up.
                
                
– Dirk Boer
                

                Apr 10, 2015 at 10:47
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                @DirkBoer I'm not familiar with bingprotect but in the past it was either Ask toolbar or Yahoo toolbar.  Annoying but not truly hurtful.  This bingprotect thing sounds like they've crossed the bridge from tacky behavior to shady.  Hopefully others users will take heed.
                
                
– JoelAZ
                

                Apr 13, 2015 at 2:58
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                @JoelAZ Good idea.
                
                
– Franklin Yu
                

                Feb 19, 2018 at 0:24
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                While I had better results with pdfcreator than saving/exporting/printing to PDF from Word, it does not preserve links, which is a severe downside to be aware of!
                
                
– Thomas K
                

                Jan 24, 2020 at 20:36
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If you are using Windows 10 then you are lucky: you donâ€™t need any third party PDF printer. Windows 10 comes with a PDF printer called Microsoft Print to PDF that you can make use of. I tried and it printed with decent resolution.

If running on Windows 8.1 or below, or requiring more functionality/better quality, JoelAZâ€™s answer is better. Just pay attention to where you download.
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                The "Microsoft Print to PDF" Printer retains the image quality better than the "Save as PDF" function, but looses quality nonetheless. The resolution is higher (maybe 600dpi?) but there are some JPEG artifacts visible. This uses no third party software and will be adequate for many use cases, therefore I'm marking this as answer for visibility. For getting the best image quality I'd recommend the answer from @JoelAZ.
                
                
– DasKrümelmonster
                

                Feb 21, 2018 at 9:35
            

        

    
	
        
            
            

        

        
            
                
                Neither the windows PDF printer or the pdfcreator preserve high quality image resolution in the PDF for me.
                
                
– Christopher John
                

                Jun 5, 2019 at 14:34
                        
                            
                        
            

        

    
	
        
            
            

        

        
            
                
                @ChristopherJohn It has been commented above that Microsoft PDF Printer is expected to lose some quality. If you have question about pdfcreator, I recommend asking JoelAZ since I don't use it myselfâ€¦ Sorry.
                
                
– Franklin Yu
                

                Jun 5, 2019 at 15:07
            

        

    
	
        
            
            

        

        
            
                
                OK I got it to work, basically you need adobe DC and to customise the settings for PDF printing so that there is no image compression. Now the PDF images are perfect.
                
                
– Christopher John
                

                Jun 5, 2019 at 16:34
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                I'm baffled as to why this is the accepted answer.  Today I'm specifically attempting to export a DOCX to PDF.  It looks fantastic printed to an actual printer, but abysmally pixelated via the Microsoft PDF Printer.  But I've been down this road before, and I've never seen good performance out of that "printer" with images containing detail or text.  (E.g. with screenshots for software documentation in this case.)  This answer even says that JoelAZ's answer is better, as the original question was indeed concerned with quality.
                
                
– s.co.tt
                

                Sep 26, 2019 at 18:29
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None of the aforementioned solutions worked for me including enabling the "do not compress images in file" and "select ISO 19005-1 complaint" options. It did not matter if I saved-as a PDF or exported as a PDF.


What DID work for me, was to create the PDF using the MS Office Microsoft Print to PDF printer option.


	Select Print from the File Options menu.
	Select Microsoft Print to PDF from the Printer drop down menu.
	Print. Specify where you want the PDF file to be created.


    

    
        
            
            
                




    

        
            Share
        



                    
                        Improve this answer
                    


                
                    
                        Follow
                    
                







    

    



            

            

    
        
            edited Mar 28, 2019 at 13:17
        

        
    

    
        

    

    
        Steeven
        
            28311 gold badge33 silver badges1313 bronze badges
        

    



            



            
                
    
        
            answered Jun 12, 2017 at 1:39
        

        
    

    
        

    

    
        wrieedxwrieedx
        
            19722 silver badges77 bronze badges
        

    





            

        

        
    
    

    






            7 
    
        
            	
        
            
                    3
            

        

        
            
                
                Do you mean you tried pdfcreator as I suggested and it too did not solve your problem either?  I find that a little hard to believe.
                
                
– JoelAZ
                

                Feb 18, 2018 at 19:53
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                Fair enough.  However to say "NONE of the aforementioned solutions worked" without having tried them is disingenuous so perhaps your answer should reflect that.  Also, it was a browser toolbar.  Further, we've established that vendor has corrected their course and no longer does that and, finally, I've provided a clean alternate installer that isolates one from those worries now and in the future.  Try or don't try, it's up to you, but don't represent that you tried my solution and it didn't work for you.
                
                
– JoelAZ
                

                Feb 20, 2018 at 4:06
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                my apologies if you took some offense.  I really don't see my post as being aggressive and certainly it wasn't meant to be.  My intent was to point out that if you say none of the solutions worked for you, you're implying you tried them all.  You then clarify that you didn't.  So the point was asking you to not represent having tried a solution that you hadn't and your answer would serve better without that implication.  Again, my apologies if you're offended by my words or tone.  There was no intent to.
                
                
– JoelAZ
                

                Feb 21, 2018 at 19:30
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                work for me! thanks! P.S. adobe pdf printer results in much worse resolution than microsoft one
                
                
– ch271828n
                

                May 11, 2019 at 13:00
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                Worked for me! Other solutions did not!
                
                
– TheSciGuy
                

                Jul 30, 2019 at 17:59
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I came across this very problem in 2020; Microsoft still has not fixed this issue.
Microsoft PDF printer does a better job for image quality than 'Save as PDF', but it's not perfect. Also, for whatever reason, most of the hyperlinks disappear.

What worked in my case was downloading LibreOffice and using LibreOffice Writer's 'Export to PDF', unchecking 'Reduce image resolution', and selecting 'Lossless compression' under Images. The images ended up looking super sharp and it kept my hyperlinks too. Not really sure how a free open source word processor could do such a significantly better job than Microsoft's paid product, but it did.
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I know this is a really old post. But I have a working solution (for me anyway).


I converted the png online to an EMF (enhanced metafile). When I use this in word and export to PDF it keeps full resolution. 


Hope this helps some.
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                Unfortunately, for me the PNG and EMF have the same resolution after exporting to PDF (Word 365)
                
                
– shemadolev
                

                Dec 10, 2020 at 9:52
            

        

    
	
        
            
            

        

        
            
                
                I had a vectored image in PDF and this solution worked for me. I opened the PDF in the open source program Inkscape and saved it as EMF. I was able to add the EMF vectored image in Word. The details/vectoring remained intact after saving the Word file in PDF.
                
                
– Coanda
                

                Apr 14, 2021 at 17:26
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I discovered the trick:
when you save as PDF, go to Options (under the PDF) and uncheck ISO19005-1 Compliant
Problem solved!
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                I did this and the picture is quite clear even at 200% resolution in PDF
                
                
– Firee
                

                Oct 16, 2015 at 11:14
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                for me this made no difference (Microsoft Office Professional Plus 2013)
                
                
– nachose
                

                Feb 5, 2018 at 14:50
            

        

    
	
        
            
            

        

        
            
                
                This worked for me in Office 2016 32 Bit :)
                
                
– z2z
                

                Jul 31, 2018 at 7:37
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If you are using the Adobe PDF Printer (i.e. not Word -> Save As PDF), you should be able to change the settings related to Images (such as downsampling or compression). Make sure you turn them off from Word (they should be in Preferences in the ACROBAT tab) and also uncheck Allow PostScript file to override Adobe PDF settings. 


You might need to click on Save As in the Adobe settings. This will create a new preset that will be used to create the pdf.


This worked nicely for me.
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                The OP specifies using "Save As -> PDF" built into Word.  Suggesting settings for a paid solution you don't know the user has access to is not useful here.   I suggest you edit or consider pulling the answer as imo it merits down-voting.
                
                
– JoelAZ
                

                Feb 18, 2018 at 19:51
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                I literally tried everything on this page and unfortunately the only one that gives high res images from a word file with png images embedded in it, is adobe DC.
                
                
– Christopher John
                

                Jun 5, 2019 at 16:35
            

        

    
	
        
            
            

        

        
            
                
                Same for me. Only Acrobat works reliantly (there's a trial version!). It also preserves all the Word features like links inside the document (e.g. table of contents, table of figures, bibliography, etc). Everything else came with huge disadvantages. Unfortunately, conversion time can increase quite a lot, especially when using lots of SVG as well.
                
                
– TJJ
                

                Dec 20, 2021 at 17:44
            

        

    
	
        
            
            

        

        
            
                
                This works great, thank you! Please add more detailed detailed descriptions how to get from the "Acrobat" tab in MS Word to the "Adobe PDF Settings" window.  If you're done with changing settings, finally, you have to use "Create PDF" (might be a sligthly different term) from the Acrobat tab to create the pdf.
                
                
– mouwsy
                

                Apr 27, 2022 at 11:12
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I've been bothered by this for years, somehow having a PDF file that looks exactly the same as your word file, just the postfix is different, is so hard.

Below are the methods I tried and the problems with each method. Just for your reference and might save some time for others.
I am using windows 10, ms word version 2008 build 13127.21064.

I am writing an IEEE paper which I want to have the links to tables, however, on the table caption, it needs to be capitalized: TABLE, but on manuscript text, it needs lowercase: table. So, what I did is cross-reference the table, insert caption name and then manually delete the letters TABLE, just leave the roman numbers I, II, etc.
So, when converting to pdf, I do not want TABLE to show up anywhere on my manuscript, also, I do not it to show up after the conversion is done, therefore, if it shows up, it is referred to as "unwanted TABLE"

	SaveAs_PDF_use it then the word file shows unwanted TABLE.
	Print_PDFwriter_hyperlinks lost
	Print_PDFCreator_hyperlinks lost
	Print_MicrosoftPrintToPDF_hyperlinks lost
	freepdfconvert.com_unwanted TABLE shows on PDF.
	Export_CreatePDF_use it then word file shows unwanted TABLE
	adobe.com_so far the best without any more follow-up actions


    

    
        
            
            
                




    

        
            Share
        



                    
                        Improve this answer
                    


                
                    
                        Follow
                    
                







    

    



            



            
                
    
        
            answered Feb 3, 2021 at 9:51
        

        
    

    
        

    

    
        RenRen
        
            2122 bronze badges
        

    





            

        

        
    
    

    






             
    
        
            

	    


        
                    Add a comment
                 | 
            
        
         
    

    




                                    


    
        
            
        
            
        
        
            1
        

        
            
        


        

    
    








            
                
                    
                

            


    
    




        


        


    
    
Just for completeness (because it hasn't been excluded in the question): with SVG graphics you no longer have to worry about "preserving quality" concerning the resolution. It scales in arbitrary sizes. This only works for graphics consisting of forms, not for photos, though.
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                But Word doesn't support SVG images.
                
                
– Andreas Rejbrand
                

                Jul 31, 2014 at 23:40
            

        

    
	
        
            
            

        

        
            
                
                You're right, wouldn't have thought about it in my worst nightmares... what a lack of feature!
                
                
– Kalle Richter
                

                Aug 1, 2014 at 1:05
            

        

    
	
        
            
            

        

        
            
                
                You can convert SVG files to EMF format (vector image format from Microsoft), which is supported by Word.
                
                
– Iván Pérez
                

                Sep 19, 2014 at 14:08
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                Note that in later versions of Word 2016, SVG support has been added, so this can be used.
                
                
– Erik A
                

                May 31, 2018 at 8:54
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If you have MS Publisher in your office suite, it gives you much greater control over the print quality of published PDFs. Where the best save option in Word is to 'Optimize for: Standard (publishing online and printing)', in Publisher you get standard, high quality, and commercial printing options with a selection of dpi tweaks available. The file size rockets, but the quality is superb!
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                Can you add more info, step by step?
                
                
– Pedro77
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The results of exporting using the "Save As" dialogue are different to the results when exporting using File->Export->Create PDF/XPS.


I found that exporting using the latter method is far higher quality by default.
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                doesn't work for me (in word 2010). resulting pdf is bad quality.
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Try this:


	Open the Word 2013 document with the images inserted. 
	Click File, Save As, and PDF from the drop-down menu. 
The Options button is displayed at the bottom of the window. 
	Click Options. 
	On the Options dialog box, select ISO 19005-1 complaint (PDF/A) in the PDF options section. 
	Save the changes.



There are other workarounds over here in this tutorial


http://wordtipsandtricks.com/2015/10/21/how-to-improve-image-quality-ms-word-pdf-conversions/
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                Does not work for me. Same low resolution and the option makes virtually no difference.
                
                
– DasKrümelmonster
                

                Oct 21, 2015 at 8:06
            

        

    
	
        
            
            

        

        
            
                
                Have you tried using EPS files instead of Jpg/Gif?
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                It worked for me: Word 2013.
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                Doesn't work in Office 365/2019. Still bad resolution.
                
                
– TJJ
                

                Dec 20, 2021 at 17:40
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If you have also access to a MAC, then another solution would be to open it in Microsoft Word for MAC (e.g., 2011). Then 'File' -> 'Save As' and select 'Format:' PDF. 


This one is the only practical solution for me that worked in the end.
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I stumbled over this problem using Word 2010. In my opinion any solution that tries to solve this while creating the PDF will fail. The problem is: as soon as you store your word document word scales the image down - regardless of the options set. 


I was able to print (PDFCreator - my prefered printer driver for HR-PDF) a QR-code (png, 1000x1000pixel, final size approx 10mm x 10mm) before saving the document in a good quality. Howerver, the moment I saved in Word, it became visibly unsharp. 


For this I think the only solution to work is the one proposed by Zerobinary99 - using a larger format and to scale down. However for practical reasons this is feasible only for small graphics. Word will soon tell you that it does not support your paper size. Further you have to recreate the whole content...


I helped myself by using a .PDF-Editor and inserted the QR code after creation of the .PDF. again. Not a real solution as well....


I learnt: Don't use WORD for this... Most users with a licence for word will have a licence for MS-Publisher as well. I think I did exactly the same thing 2 years ago in Publisher without this problem...
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If you are placing images in your document that originate in vector format, you can use SVG files instead of JPG or PNG files - Word 2010 will read them. This may be obvious to most, but it wasn't to me. 


The print-to options, including using PDFCreator, brute-force the result, and even if your placed PNG has insane pixel size and looks great in Word, in the PDF it'll still be pixelated and yield a massive PDF size. At least it did with all permutations I tried. Finally I generated a bunch of different formats of vector files and found that Word could work with SVGs. And the resulting PDF looked good, even when using Adobe's Save-as-PDF file-save option - benefit of that to printing was a vastly smaller file size that looked clean.


This won't help you if you're using photos, but if it's just a logo or graphic, this is worth a look.
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Word scales the image automatically depending on the paper size, so you need to increase it to increase the PDF's resolution. 


	The PNG you want to turn into pdf has a resolution of 1600x1600, so use a paper size that reflects this aspect ratio. Set your paper size to 55.87cm x 55.87cm (biggest Word 2007 supports)

	Import the PNG and stretch it out to the maximum size the page supports.

	Export it to PDF and enjoy your high res pdf :)
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                The real document should be 85mm by 55mm, and the image is 10mm by 10mm. Changing that is not really a solution imho. The printer supports something like 600dpi, so 96dpi will definitely look blurry.
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                Another solution would be edit your pdf with an editor and replace the low-res picture with a high-res version. There are free editors available. There's even one that allows you to edit pdf-files online in your browser if you don't mind the lack of data security.
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A workaround is to install doPDF. You'll get crisp images, no file degradation, and easy to change dpi and small output files. Another alternative is PrimoPDF which is also a PDF Printer like doPDF, but it may generate huge files, and it does have a problem that the font looks OK on screen but jagged when printed, even with fonts like Arial.
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Try this: 


By default, MS Word compress images which can reduce the image quality when converting to PDF. 
You can turn off this setting as follows:


	In Word, click File, Options.
	Click Advanced, scroll down to Image Size and Quality.
	Turn off Discard editing data. 
	Select Do not compress images in file.
	Select Set default target output to 220 ppi.  
	Save the changes.
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                I tried this option already (see question), to no avail.
                
                
– DasKrümelmonster
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                This does not seem to influence PDF export.
                
                
– bers
                

                Aug 13, 2020 at 16:34
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I had been facing the lose of image quality when converting from Word to PDF. I found that in addition to the advanced settings, we need to check the following option:





The standard option must me selected while saving.
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Another solution would be edit your pdf with an editor and replace the low-res picture with a high-res version. There are free editors available. There's even one that allows you to edit pdf-files online in your browser if you don't mind the lack of data security.
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                Welcome to Super User.  This is more of a hint of something to explore than an actionable solution.  Can you expand your answer to provide more detail of how to accomplish this?  Thanks.
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